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CHAPTER II 

LITERATURE REVIEW 

 

 

 This chapter describes about the information of traditional market, 

traditional food, promotions, design and booklet. 

 

1.1. Culinary Tourism 

 Culinary tourism is one aspect that can attract tourists. It happened because 

culinary tourism can inflict the uniqueness that can be one of the characteristic of 

each countries. According to Leheup (2011) Culinary tourism includes any 

tourism experience in which one learns about, appreciates, and/or consumes food 

and drink that reflects the local, regional, or national cuisine, heritage, culture, 

tradition or culinary techniques. This culinary tour is a part of the type of tourism 

that exists, because it is not complete if tourists who come do not try traditional 

culinary in that area. It is also related to Suryadana (2009) as cited in Nathasya 

(2014), he said that culinary tourism is defined as a tour that provides a variety of 

services and activities suitable to meet the needs of tourists built for recreation, 

relaxation, education and health. 

 Meanwhile, Long (2004) defines culinary tourism is about food as a 

subject and medium, destination and vehicle, for tourism. It is about individuals 

exploring foods new to them as well as using food to explore new cultures and 

ways of being. It is about groups using food to “sell” their histories and to 

construct marketable and publicly attractive identities, and it is about individual 

satisfying curiosity. According to Hall & Mitchell (2003) as cited in Syafitri 

(2019), Food tourism there is a need to differentiate between tourists whose 

activities, behaviors and even, destination selection is influenced by an interest in 

food. 

 Based on some definitions above, the writer can conclude that culinary 

tourism is a journey which includes the activities of consuming local food from an 

area, travel with the main goal to enjoy food and drink or visit a culinary activity, 
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visit the food and beverage industry center, and to get different experience when 

eating food and drinks. One of the place for enjoy the culinary tourism is in the 

traditional market, because the tourists not only feel the taste of the food but also 

they can socialize with the local people who sell traditional food. 

 

1.2. Traditional Market 

 Sadilah (2011) said that traditional market is an outdoor place, which 

process of buying and selling with bargaining process. Traditional market has 

characteristics that place is not too extensive, the goods sold are not to many 

kinds, the management system is simple, does not offer the convenience of 

shopping. There is still haggling prices with merchants, products are sold not on 

display are open so that customers do not determine whether the retailer has the 

item sought or not. 

  Meanwhile, Geertz (1992) as cited in Zafirovski (2001) a market economy 

is traditional in a sense that its function is regulated by trade customs which are 

considered sacred because it has been continuously used for centuries, but it is not 

in the sense that this market economy describes a system where economic 

behavior is not sufficiently differentiated from the kinds other kinds of social 

behavior. From a different perspective, Geertz argues that traditional markets 

indicate a place that is intended for activities that are indigenous market trade, as 

has been practiced for a long time (directed). Traditional market more 

characterized by small-scale economic type bazaar. Because of this, traditional 

markets directly involve more mutual traders competing with each other in that 

place. In addition, this market is interesting more diverse visitors from various 

regions. Not losing Importantly, traditional markets have proven to provide 

opportunities for the sector informal to be involved in it (Geertz, 1963). 

 Based on some definitions above it can be concluded that traditional 

market is an outdoor place that managed by the Government and the main 

container for selling basic needs products produced by small and medium scale 

economic actors. Market also can be the place for social interaction that the actors 
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are the shoppers and traders. They are farmers, fishermen, craftsmen and home 

industry (people's industry). 

 

1.3. Traditional Food 

  Traditional foods played a major role in traditions of different culture and 

regions for thousands of years including foods that have been consumed locally 

and regionally for and extended time period. Preparation methods of traditional 

foods are part of the folklore of country or a region in terms of the use of  

traditional ingredients (raw material of primary products) or traditional 

composition or traditional type or production or processing method (Glibetic, 

2013).   

 According to Soekarto (1990) these food is grown at this place and called 

the traditional food. Traditional foods are foods (including snacks) and drinks as 

well as a mixture of materials (ingredients) that are traditional has been used and 

developed in the area or local community. Traditional foods that have a wide 

range of herbs and spices can be expected to be potential difficult to emulate other 

countries. Also according to Lestari (2014) traditional foods are foods and 

beverages commonly consumed by a particular community, with a distinctive 

flavor that is accepted by the community.  

 Based on some definition above, it can be concluded that traditional food 

is food that is grown in an area which is the characteristic of the area and 

consumed by particular community. Traditional food also can define the culture of 

the country because each countries have their own varieties and ingredients for 

their traditional food.  

 To make traditional food known to many people, they need media to 

promote it. One of the media that can be an option for writer is a booklet. 

 

1.4. Promotion 

 Understanding the promotion according to Saladin and Marty (2002), 

Promotion is information of communication sellers and buyers aims to change 

attitudes and behavior of buyers, who previously not know becoming familiar so 
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that it becomes a buyer and remembering product. While understanding the 

promotion according to Alma (2006), Promotion is a kind of communication 

which gives explanations and convince potential customers of the goods and 

services with the aim of attention, educate, remind and convince potential 

customers. Saladin (2004) divided promotion into 5 types. 

 They are advertising, personal selling, publicity, sales promotion, and 

direct marketing. 

1. Advertising is a form of non-personal promotion by using various media that 

intended to stimulate the purchase. 

2. Personal selling is a form of personal promotion with an oral presentation in a 

conversation with a prospective buyer who intended to stimulate the purchase. 

3. Publicity is a form of nonpersonal promotion of the service or specific business 

entity with reviewing the information or news about it. 

4. Sales promotion is a form of promotion besides the three forms above that 

intended to stimulate the purchase. 

5. Direct  marketing  is  a  form  of  individual  sales  directly  intended  to 

influence the consumer purchase. 

 Promotion is essentially a marketing communication, meaning that 

marketing activities that tries to spread information, influence or persuade, or 

remind the target market for the company and its products to be willing to accept, 

buy and loyal to the products offered by the company concerned, Tjiptono (2001). 

 Here are definitions of some media promotion by Kusrianto (2007): 

1. Leaflet (flyer): The sheets of print paper folded into two pages or more. 

2. Folder: Sheet molding material that is folded in half like a map or a book to 

be easily carried. 

3. Brochure (booklet): Printed materials consisting of multiple pages bound so it 

is similar with a book. 
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4. Catalog: A kind of brochure that contains details on the types of products / 

services and sometimes equipped with pictures. The size can vary, from of 

pocket until the phone book, depending on the needs of business. 

5. Stationery Set: namely, envelopes, letterhead and pens are usually placed in a 

hotel room. It has function not only as a service from the hotel, but excluding 

postal material because there is the name of a product or service, complete 

with addresses and phone numbers. 

6. Inserts (Stifler): Leaflets inserted or placed in the box a product. Usually a 

description of use of the product, or other products that are manufactured by 

the same company. 

7. Hanging Mobile: A tool moving displays when exposed to wind, the 

placement is hanged. 

8. Wobbler: Tool displays a way of placing a wall-mounted or on shelves using 

plastic or similar material so that the image becomes supple and moving. 

Usually in the form of two-dimensional. 

9. Self Talker: The print media to promote a product by placing it directly on the 

rack. 

10. Flag Chain: The series of small flags to display an image product, brand, 

slogan, or a combination of all of them. 

11. Poster: Poster display and full color is usually used as a decoration of the 

room with a stick on walls, shop windows, or walls of the showroom. 

12. Sticker: Promotional material most widely and frequently used by companies 

to promote their products because it is very flexible. 

13. Box Dispenser: Having regard to leaflet or brochure as it is used to put those 

goods. 

14. Model: The model here is more likely to serve as decoration or decoration, 

and usually in the form of miniature. Other forms, merchandise/souvenirs, 
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clocks, ashtrays, lighters, chains, locks, calendars, t-shirts, hats, umbrellas, 

etc. 

 The promotion is a way to inform or notify the prospective buyer of the 

products offered by notifying the places where people can view or make a 

purchase (Yoeti, 2006). 

 While, Promotional purposes according to Lamb, Hair, McDaniel (2001) 

as follows: 

1. Provide Information (Informing) 

a. Increase awareness of the new product, class of products, or product 

attributes. 

b. Explain how the product works. 

c. Suggest a new use of a product. 

d. Building the image of a company. 

2. Persuade target customers (persuasive) 

a. To encourage brand switching. 

b. Changing the customers' perception of product attributes. 

c. Influencing customers to buy now. 

d. Enticing customers to come. 

3. Reminds (reminding) consists of : 

a. Remind consumers that the product may be required in the near future. 

b. Remind consumers where to buy the product. 

c. Maintain awareness of consumers. 

 

 Based on definitions above, the writer can concluded that Promotion is a 

kind of communication which gives explanations and convince potential 

customers of the goods and services with the aim of attention, educate, remind 

and convince potential customers. In short, Promotion is a way to inform people 

about product or service. It can be to persuade them to do the purchase and 

becoming a buyer. 
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1.5. Design  

 According to Johnston (1991) cited in Taylor & Francis (2011), says that 

design is a process of making something that inherently has emergent products or 

spatial patterns in given time-frames that manifest the ever-changing realities in a 

community occurring within the process. Furthermore, The Cambridge Dictionary 

of American English (2015) states that design is the creation of a plan or 

convention for the construction of an object or a system as in architectural 

blueprints, engineering drawings, business processes, circuit diagrams and sewing 

patterns. While, Brinkkemper (1996) as cited in Chen (2001) Designing often 

necessitates considering the aesthetic, functional, economic and sociopolitical 

dimensions of both the design object and design process. It may involve 

considerable research, thought, modeling, interactive adjustment, and redesign. 

Meanwhile, diverse kinds of objects may be designed, including 10 clothing, 

graphical user interfaces, skyscrapers, corporate identities, business processes, and 

even methods of designing.  

 Sitepu (2006) states that there are five elements of design. They can be 

classified as:  

1. Line  

Line is divided into four, they are: vertical, horizontal, diagonal, ad curves. In 

the graphic design, line is used to separate the positions between the other 

graphic elements within the page. It also can be used as a bookmark of specific 

parts with the purpose for the explanatory of the reader. Line is also used as a 

separator between the two parts of different publications or provides emphasis. 

For example, it can be used for separating the information in a book.  

2. Shape  

Shape is a field that occurs because it limited by a contour (line) and or it 

limited by the different color or by the dark light on shaded or texture. Shape 

can be a natural form (figure), which does not at all resemble the natural form 
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(non-figure). Shape has a change in the form of stylized form, dissertation, and 

transformation. This meaning is constructed in two-dimensional graphics.  

3. Space   

Space occurs because of the perception of the depth that feels far and near, 

high and low, looking through the sense of sight. This element is used as an 

element of breathing space for the reader’s eye. It means to make the reader not 

too tired to read the text is too long. The empty space provides the separation 

between the columns of text. In addition, it gives the impression of a roomy 

and neat design. 

4. Texture  

Texture is the visual elements that show a sense of surface material (material) 

which is intentionally created and presented in the order to attain such a form, 

either in the form of real or pseudo. For example, the impression of wood is 

texture, hair, or glasses.  

5. Color  

The color of an object is determined how light falling on the object and 

reflected back to our eyes. Because light has a spectrum (systematic series) 

color, and that color spectrum is exactly what helps humans recognize colors. 

In applying color in a design, you can refer to the color wheel. To produce 

harmonious colors, use colors that are close to one another and each color has 

their own meaning.    

 While according to Keung (2019), she said that there are seven basic 

elements of design. They are : 

1. Line 

Lines are the most basic elements of design. They come in all shapes, sizes, 

and colors. Lines have direction; they can be visible or invisible and can help 

direct the eye to a specific spot. The thickness of a line can also communicate 

certain cues. Bold and thick lines can draw attention, while thin lines are the 

opposite. Most if not all layouts contain invisible lines. Grids are made of 
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multiple lines and lend structure to a page. Lines can be used to create 

demarcation on a specific section of a design. A simple line can carry so 

much—for instance, a squiggly line is perceived as young and fun compared to 

a straight line. Lines don't necessarily have to be solid. Dashed and dotted lines 

can also be used and have a friendlier feel than a solid line. Straight lines 

usually come across as a steady and static element. On the other hand, curved 

lines are dynamic and give energy to the design. 

 

 

Figure 2. 1 

 Kinds of Line 

source: http://design.tutsplus.com 

 

2. Color 

Colors create moods and can say something different depending on the 

connotations associated with it. Color can create an emphasis on specific areas 

of your design layout. This element contains multiple characteristics:  

a. Hue is the name of a color in its purest form. For instance, cyan, magenta, 

and green are pure colors.  

b. Shade is the addition of black to a hue in order to make a darker version.  

c. Tint is the addition of white to a color to make a lighter version. 

d. Tone is the addition of grey to make a color muted.  

e. Saturation refers to the purity of a color. A specific color is most intense 

when it is not mixed with white or black. 
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Figure 2. 2  

Kinds Of Color 

source: http://design.tutsplus.com 

 

3. Shape 

A shape is the result of enclosed lines to form a boundary. Shapes are two-

dimensional and can be described as geometric, organic, and abstract.  

a. Geometric shapes have structure and are often mathematical and precise 

(squares, circles, triangles). You’ll notice that the Swiss graphic design 

movement from the 1950s used mostly geometric shapes in their designs. 

Shapes can add emphasis to a layout. 

b. Organic shapes lack well-defined edges and often feel natural and smooth. 

Shapes add emphasis to a layout. 

c. Abstract shapes are a minimalist representation of reality. For instance, a 

stick figure of a person is an abstract shape. Logos are mostly represented 

by abstract figures to show the type of business. The icon pack below is a 

great example of abstract shapes conveying real-life objects and situations. 

 

 

Figure 2. 3  

Kinds of Shape 

source: http://design.tutsplus.com 

http://design.tutsplus.com/
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4. Form 

On a page, form is the positive element over the space, the negative element. A 

dot, line, or shape is a form when placed on a page. Unfortunately, form and 

shape are mostly used interchangeably. A form can be either two-dimensional 

or three-dimensional. Many also believe that form is a shape that acquires 

three-dimensional values, but the correct term is volume. Form and shape are 

mutually dependent because changing one would affect the other. The spatial 

relationship between form and space can create tension and add 3D qualities to 

your design. Form and space will lend the design lots of visual activity that can 

help keep viewers engaged. To create a 3D effect in the design, add the 

shadows, stack multiple elements, or play with color. 

 

 

Figure 2. 4  

Picture of Form (Positive Space) 

source: http://design.tutsplus.com 

 

5. Value 

Value refers to the degree of lightness and darkness of a specific hue. Yellow 

has a higher value than purple because it is closer to white. Value changes 

create contrast on a page. In design, use different tonal values to create 

emphasis in the design. Create the illusion of movement by overlapping 

multiple elements with different values. Value also defines the spatial 

relationship between elements. If color values are close between the elements 

and space, then the design will look flat. If there is a strong contrast between 

the elements, then the form will be extremely noticeable.  

http://design.tutsplus.com/
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Figure 2. 5  

Picture of Value 

source: http://design.tutsplus.com 

 

6. Space 

Space is the area that surrounds a shape; it creates a form within the space. 

Think of it as music: space is the silence between the notes of a song. If all the 

notes were played together, that would turn into noise. The negative space is 

the area that is not occupied by any elements. In essence, it is the background 

color that you are able to see. For instance, abundant negative space in a layout 

results in an open, airy, and light background. The lack of negative space can 

result in a cluttered design. Visually speaking, a layout needs space to achieve 

a level of clarity within the design. Negative space is a very important element 

to consider as designing a piece. 

 

 

Figure 2. 6  

Picture of Space (Negative Space) 

source: http://design.tutsplus.com 

 

 

http://design.tutsplus.com/
http://design.tutsplus.com/
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7. Texture 

Texture adds a tactile appearance to a design layout. Imagine how a design 

piece would feel if you touched it. The goal of texture is to add depth to a 2D 

surface. Texture can be applied graphically through patterns, either digitally 

created or an image mimicking the desired pattern.  

 

 

Figure 2. 7 

 Kinds of Texture 

source: http://design.tutsplus.com 

   

 Based on some definitions above, the writer concluded that design is 

process of making something or creation of a plan for the construction of an 

object. It is often necessitates considering the aesthetic, functional, economic and 

sociopolitical dimensions of both the design object and design process. There are 

some elements of design such as line, shape, form, space, texture, value and color 

that can impact on how the design is perceived. 

 

1.6. Booklet  

 According to Geoff (2010) cited in Macmillan (2012) describes the 

booklet cover the story of how the book came into being or how the idea for the 

book was developed, and include thanks and acknowledgments to people who 

were helpful to the author during the time of writing. Furthermore, Utami (2012), 

booklet is a small book which has some information about products, events, 

brands, and so on. While, Cutlip (1994) suggested that the booklet is a short 

publication which comprises several pages that contain a brief description that 

contains the organization or company for public knowledge. While, Gema (2012) 

http://design.tutsplus.com/
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explains booklets usually consists of several pages and often have a cover, title 

page, bound either simply using staples or bound with decorations for example 

using a ring. Meanwhile, according to Holmes as cited in Mintarti (2001) says that 

the booklet contains of 20 pages with a size of 20 x 13 cm. The contents of a 

booklet are clear, decisive , easy to understand and interesting. 

 In concluded that, booklet is a small book usually consists of several 

pages, have a cover, title page and bounding with simple staples or decorations. 

Booklet has function as short publication that contains a brief description and 

information about products, events, brands and so on. The contents of the booklet 

also need to be interesting and easy to understand.   

 

1.6.1.  Advantages and disadvantages of booklets 

 According to Gustaning (2014), as printed medium, a booklet has 

advantages. This medium can be used easily as a medium or tool for self-learning, 

low cost and more durable than audio and visual media. A booklet is usually 

aimed to increase the knowledge because a booklet gives specific information. 

Besides, Perangin Angin (2013) claims that there are many more advantages of a 

booklet. First, it can be learned by everyone. Second, a booklet design also has 

attractiveness to increase the passion to learn. Last, a booklet does not need 

electricity so it is easy to carry everywhere. 

 However, this medium has also disadvantages. Perangin Angin (2013) 

states that a booklet does not have any sound effects and motion effects, and it is 

easily folded or torn if it is no stored properly. Meanwhile, according to 

Gustaning (2014) there are some disadvantages. First, this medium takes a long 

time for printing based on orders and tools that are used for printing. Second, it 

will be more expensive to print out pictures or photos. Third, a booklet needs 

good care to make pictures or text is faded or damage. The last, a booklet will 

decrease the reader’s interest if it is too thick.  
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1.6.2.  How to Design Booklet 

 According to Weedmark (2015), design booklet can be done using 

Microsoft Publisher program. The following steps of making booklet through 

Microsoft Publisher program. 

1. Selecting a Booklet Page Design 

a. Open a blank publication. Click the Page Design tab and then click the Size 

icon. Select More Preset Page Sizes at the bottom of the drop – down menu. 

b. Click the Booklets folder. Other folders contain other page sizes. 

c. Select any booklet that suit to the project. For a booklet made from letter – 

sized paper that is folded in landscape mode, select the first 1/2 Letter 

Booklet option, which has page sizes of 5.5 by 8.5 inches. This booklet 

generates four pages per sheet of paper. The first and the fourth page are 

printed on one side of the sheet, with the second and third pages on the other 

side so when folded the sheet in half, the four pages can be read in order. 

2. Adding Text to the Booklet 

a. Click the Insert tab and then Click the Draw Text Box icon. Drag the cursor 

over the first page to make the title appear. If align the text box perfectly 

over the margins after release the mouse button. This behavior is normal and 

it ensures that the text inside the text box will be aligned with the page 

margins. 

b. Type or paste the title in the text box. Highlight the text by dragging the 

cursor over every letter to format it. click the Home tab and select a Font, 

Font Size and Alignment for the title. 

c. Draw text boxes on each of the other pages. Begin typing the content for the 

booklet in the first text box after the title or paste it from another document. 

When there is too much text for the box, an Overflow Indicator appears on 

the border. Click the Overflow Indicator again to link it to the third, then 

link the third text box to the fourth until the four – page booklet is filled. 
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d. Highlight all of the text by clicking the first text box containing the 

booklet’s content and pressing Ctrl + A. Click the Home tab and format the 

text as desired. To use headings in the booklet, highlight the heading and 

then select a style from the Style icon in the Home ribbon. 

3. Adding Images to the Booklet 

a. Add images from your computer by clicking the Insert menu and then 

clicking Pictures. To find images using Bing Image Search, click Online 

Pictures. 

b. Drag any corner of the image to resize it without distorting its aspect ratio. 

To move an image, just drag it until it appear. 

c. Right – click the image and click the Tect Wrap icon to adjust the way text 

wraps around the picture. By default, Text Wrap is enabled, but that make 

the image appear beneath the text, over the text, or have it in – line with the 

text.  

4. Printing the Booklet 

Click the file tab when the booklet is ready to print. Select Letter – sized paper 

in the Settings section and then examine each page in the Preview window. 

Click the Arrow beneath the preview to examine other pages. 

 While according to French (as cited in Utami, 2017), there are several steps 

to create a booklet:  

1. Choosing a good title and subtitles 

The selection of title and subtitles is the most important thing to define the  

content of booklet. It is better to choose a narrow and specific topic to make the 

reader easy to understand.  

2. Using a logical structure and concrete format  

In the process of making a booklet, the writer should follow the rules and 

guidelines in making a booklet to create an interesting booklet.  

3. Adopt the appropriate writing method  
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Creating a booklet could not be done only with writing because writing a 

booklet has a large reader scale so it must be done carefully by pay an attention 

to some aspects.  

 

4. Using a good cover  

Commonly, people read and judge a book by its cover. A good cover can 

attract the reader to read and buy a booklet. The other function of cover is 

cover can be a medium of promotion that has a purpose to give the influence 

that the booklet looks appropriate for the reader.  

 There are some steps that must be noticed in making the content of the 

booklet given by Fayra (2009) as follows.   

1. The Notion or Idea  

The first step to be taken is to collect ideas. For example, the idea to create a 

book alloys job training. This idea appears due to the phenomenon that takes 

place in the workplace. The phenomenon that takes place is not the coach for 

giving training to students and students who follow the program of street 

vendors in the workplace.   

2. Focusing on The Idea  

The next, focus on the ideas that has been created. Focus on this idea means 

delve deeper into the science and understand of the ideas which will write in 

the booklet. When establishing the idea of what will be discussed, in order to 

strengthen the science that will represent in a booklet to be written, add a 

reference from another source, of course, by referring to posts that are not 

considered as plagiator.   

3. The Skeleton of Booklet  

In making a booklet should be make the skeleton first. This is done so that the 

writing focused and stay focused on the idea that to be delivered, not to 

deviate to other questions which actually does not need to be discussed in the 

booklet. Framework also makes it in  drafting. With the framework of the 
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booklet, the author will be directed in making a booklet, so that the contents 

of the booklet will be focused clearly on the things that will be explained. 

4. Making The Draft  

When the first time create a booklet, the booklet may not be successfully 

made. Writer should write anything that wanted to convey through writing. 

The first writing is basically still the words 'coarse' means the text still needs 

to be addressed in order to become a better writing, to inform the contents 

effectively. Conceptional booklet will have better results than booklet that are 

not based on the concept.   

5. The Writings  

The most difficult thing is done by a writer, is to assess the own writing. 

Naturally the writer can assess even criticizing the writings of others, but the 

writer is often less able to assess the writing let alone criticize the own posts. 

However, after writing the content of a booklet, the booklet should be read 

back. Usually, when read back the contents of the booklet that already 

written, there will be find many mistakes in the text. There are better if asking 

for some people to read the booklet that we have made. Ask people opinion 

and tell the errors that exist in the booklet, so it is easier to fix it.   

6. Improvisation Article  

After studying the writings that have been there and know the errors 

contained in the text, or even in the text there are things that are less 

necessary and should be eliminated from the contents of the booklet. We 

must improvise the text. The trick, of course, by eliminating things that are 

considered less important, correct mistakes in the writing and preparation of 

the booklet, as well as choose a better vocabulary, more efficient but does not 

reduce the aesthetics of packaging writings.   

7. Revision  

Revisions should be made to improve all inscription. In some cases, usually 

when a revised many writer say the same revision by rewriting part or the 

whole booklet. This revision aims to make a booklet better than before.     
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8. Editing  

Once the revision has been done, the last thing in writing is editing. Editing is 

done to fix the writing (if any writing or using the wrong vocabulary) also fix 

the layout and the pictures of the booklet. When the reader has an interest to 

know the contents of the booklet, it will be easier for them to understand the 

purpose of writing that we make.   

9. Designing Lay-Out Content, Background, Pictures, and Cover  

The appearance of a booklet, is affecting the delivery of the information 

contained therein. For this reason, in addition to the package contents of the 

book needs to be taken more seriously. Alloy color, suitability typeface, font 

size accuracy, use of tables, graphs, images and so forth also determine the 

quality of a booklet created. Interesting to see the contents of the booklet 

(with a mix of colors, application of animation, etc.) will stimulate the senses 

of seers not get bored while reading the booklet. Thus, the content will be 

easily conveyed. Another thing is the cover design. Volume booklet, should 

be designed to represent the information contained on the contents of the 

booklet. Cover that can attract growing interest to find out more about what 

deliver in the content of the booklet.   

10. Binding  

After arranging the booklet has been completed, the booklet is ready to be 

stapled. There are so many places that provide bindery services so you can 

use the service, for example in a photocopy or printing. Or, if possible, bind it 

by yourself. 

 Hicks (2017) stated that creating a booklet through Microsoft Publisher is 

a cost-effective way of doing something creative for your work or performance. 

Microsoft Publisher allows users to easily create a variety of publications, such as 

flyers, brochures and booklets. 

 Based on the opinion of some experts above, the writer concluded that to 

create a booklet it should have a concepts or idea before create it (softcopy or 
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draft of a booklet) for example, choosing a good topic, using a logical structure 

and concrete format. After created about the idea and the concept, the next step is 

start to create a hardcopy of the booklet through Microsoft Publisher which is one 

of an effective way to create a booklet. 

 

1.6.3.  Booklet Binding Methods 

 Johnson (1990) states that the process of bookmaking is introduced when 

several sheets of paper are folded, inserted one inside the others, and stapled or 

sew in the center. If desired, the booklet can be strengthened with a piece of book 

cloth pasted over the back either before or after the sewing. Meanwhile, Cendra 

(2011) claims that the first thing should be determined in choosing types of 

bookbinding for books, catalogs, booklets, company profiles, or presentation 

materials is types of cover book (hardcover or paperback). The binding techniques 

vary depending on the amount of paper and client’s wishes. There are four 

binding techniques more commonly used by many people as follows: 

1. Plastic Comb Binding 

This type is cheaper than other types of bookbinding. This type allows for 

books, booklets, catalogs or company profile to easy to duplicated by 

photocopy, lightweight and content can be added later or removed when it is no 

relevant anymore. The main disadvantages of plastic comb bindings are usually 

done manually by hand made and when done in large numbers would be very 

inefficient and ineffective so it will take high costs for the production process. 

2. Ring Spiral Binding 

Ring spiral binding or spiral coil binding is more expensive than plastic comb 

binding in production costs. This type has two kinds of materials. There are 

plastic and wire. Books, booklets, catalogs, or company profile bound can be 

opened even bent backward thus easy to read or duplicated. 
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3. Saddle stitch binding 

This type has two kinds of bound. There are middle and edge binding. In this 

type of binding, the content of books, booklets, catalog, or company profile 

stacked along with the cover and then stapled together. This type is suitable for 

books, booklets, catalogs or company profile which has the same thickness or 

type of cover paper with its contents. 

4. Perfect binding 

Perfect binding is the binding technique used for bookbinding by publisher 

especially paperback. This technique is done by pasting the left side of the page 

with glue. After it dries, the cover glued together with the content of book. This 

is the ideal choice for mass-produced books because of low cost and easy to 

work by machine. However, this type of binding is not recommended for book 

which is often read because it tends to be easily. 

 


